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Cannot	opens	in	outlook

Now	wait	the	repair	process	to	complete.	In	this	case,	open	Outlook	in	safe	mode	where	your	add-ins	aren’t	loaded	and	remove	any	suspicious	add-ins.	Outlook	caches	various	files	to	speed	up	your	app	experience.	Now	close	Outlook	and	then	start-it	again	normally.	Rebuild	the	Outlook	database.	Select	Online	Repair	or	Quick	Repair.	*Note:	Quick
Repair	scans,	and	replaces	damaged	files	with	new	ones.	5.	Follow	these	steps	to	disable	add-ins:	Go	to	File	>	Get	Add-ins.Select	My	Add-ins.Choose	an	add-in.Right-click	the	add-in	and	select	Remove.	Then,	reopen	Microsoft	Outlook	and	see	if	that	works.	In	this	box,	type	the	following	command	and	press	Enter:	outlook.exe	/cleanviews	The	command
launches	Outlook	and	clears	your	view	settings.	3.	From	the	File	menu	select	Options.	It's	not	uncommon,	and	you	can	easily	make	Microsoft's	email	and	calendar	app	open	with	a	few	simple	fixes.	If	Outlook	opens	intermittently,	seize	the	opportunity	to	check	for	updates	via	Help	>	Check	for	updates.	Quick	Tips	Running	the	Office	repair	tool	can	help
fix	various	issues	with	Microsoft	Outlook,	including	this	one.	Step	1:	In	the	Outlook	app,	click	on	the	File	menu	at	the	top.	The	Outlook	freezing,	crashing	and	not	opening	issues	usually	appears	because	of	one	of	the	following	reasons:	How	to	fix:	Outlook	Freezing	or	Crashing	when	opening	(Outlook	2019,	2016,	2016	&	Outlook	for	Office	365).	Luckily,
you	can	delete	Outlook’s	cache	files	without	affecting	your	stored	data	like	emails	and	contacts.	We’ll	show	you	what	to	do	on	your	Windows	11	or	Windows	10	PC.	A	startup	issue	with	the	navigation	pane	can	prevent	some	versions	of	Outlook	from	opening	correctly.	If	that	doesn't	work	(every	Outlook	version	is	a	little	different),	try	these	steps:
Select	File	>	Options	>	Add-ins.In	the	Manage	section,	select	Go.Clear	the	check	boxes	next	to	the	add-ins	you	want	to	disable.Select	OK.	These	add-ins	may	be	working	incorrectly,	causing	the	app	not	to	launch.	Here,	enable	the	"Full	Scan"	option	and	choose	"Scan	Now."	Wait	for	the	antivirus	to	scan	your	system,	find	any	viruses,	and	remove	those
items.	Click	the	three-dot	menu	icon	next	to	it	and	select	Modify.	Last	updated	on	01	August,	2024	The	article	above	may	contain	affiliate	links	which	help	support	Guiding	Tech.	Your	app	will	rebuild	these	files	as	you	send	and	receive	emails	as	well	as	use	other	app	features.	If	Outlook	opens	and	works	fine	in	safe	mode,	disable	all	the	add-ins	and	re-
enable	them	one	at	a	time.	to	do	that:	1.	To	fix	this,	press	Ctrl	+	Shift	+	Esc	to	open	Task	Manager.	Try	these	troubleshooting	steps	in	the	order	presented	here,	from	simple	to	more	complicated.	The	process	is	fast	and	does	not	require	an	internet	connection,	while	Online	Repair	requires	an	internet	connection	and	it	takes	longer	to	complete.	Let	me
know	if	this	guide	has	helped	you	by	leaving	your	comment	about	your	experience.	It's	also	available	here:	/Applications/Microsoft	Office	[version]/Office/.Select	the	identity	of	the	database	you	want	to	rebuild.Choose	Rebuild.When	the	process	is	complete,	restart	Outlook.	Some	common	culprits	include:	Problematic	add-insDamaged	filesA	corrupted
profileNavigation	pane	issues	There	are	other	issues,	too,	that	can	contribute.	Step	1.	To	access	the	tool,	open	Control	Panel	and	select	"Uninstall	a	Program."	Select	your	Microsoft	Office	installation	on	the	list	and	choose	"Change"	at	the	top.	Restart	your	Mac.	At	Data	files	tab,	choose	the	Outlook	data	file	(PST	or	OST)	and	click	Open	File	Location	to
find	its	storage	location	on	the	disk.	The	next	method	to	troubleshoot	issues	that	cause	Outlook	to	crash	or	stop	responding,	is	to	repair	MS	OFFICE	apps.	Try	using	Outlook	in	Safe	Mode	to	check	if	one	of	your	add-ins	is	causing	the	problem.	Click	Add	to	create	a	new	profile.	Search	your	computer	for	Scanpst.exe	(the	Inbox	Repair	tool).	Reset	Your
View	Settings	in	Outlook	Sometimes,	Outlook	fails	to	open	when	it	can’t	load	your	view	settings	in	the	app.	Open	Run	via	Win	+	R,	and	then	execute	this	command:	outlook.exe	/resetnavpane	The	following	troubleshooting	techniques	apply	to	Outlook	2016	for	Mac	and	Outlook	2011	for	Mac.	Now	type	outlook.exe	/safe	and	press	Enter	to	start	Outlook
in	Safe	Mode	(without	add-ins).	Here,	we	list	fixes	for	the	possible	causes,	starting	with	the	most	likely	culprit.	Scan	your	computer	for	malware.	Now	open	another	Explorer	window,	and	open	the	SCANPST.EXE	tool	from	the	following	location	on	the	disk,	depending	on	the	version	of	Windows	and	Office	installed:	Office	365,	Office	2019	&	Outlook
2016	Click	to	Run	versions:	C:\Program	Files\Microsoft	Office\root\office16\	Outlook	2019,	2016	(32-bit)	&	Windows	(32-bit):	C:\Program	Files\Microsoft	Office\root\Office16\	Outlook	2019,	2016	(32-bit)	&	Windows	(64-bit):	C:\Program	Files	(x86)\Microsoft	Office\root\Office16\	Outlook	2019,	2016	(64bit)	&	Windows	(64bit):	C:\Program
Files\Microsoft	Office\root\Office16\	Outlook	2013	(32bit)	&	Windows	(32bit):	C:\Program	Files\Microsoft	Office\Office15	Outlook	2013	(32bit)	&	Windows	(64bit):	C:\Program	Files	(x86)\Microsoft	Office\Office15	Outlook	2013	(64bit)	&	Windows	(64bit):	C:\Program	Files\Microsoft	Office\Office15	Outlook	2010	(32bit)	&	Windows	(32bit):	C:\Program
Files\Microsoft	Office\Office14	Outlook	2010	(32bit)	&	Windows	(64bit):	C:\Program	Files	(x86)\Microsoft	Office\Office14	Outlook	2010	(64bit)	&	Windows	(64bit):	C:\Program	Files\Microsoft	Office\Office14	Outlook	2007	&	Windows	(32bit):	C:\Program	Files\Microsoft	Office\Office12	Outlook	2007	&	Windows	(64bit):	C:\Program	Files	(x86)\Microsoft
Office\Office12	Account	Settings	>	Account	Settings.Go	to	the	Email	tab	and	select	your	profile	from	the	list.Choose	Repair	(this	option	isn't	available	for	Outlook	Exchange	accounts).Follow	the	prompts	to	complete	the	wizard	and	then	restart	Outlook.	Simultaneously	press	the	Windows	+	R	keys	to	open	run	command	box.	To	do	that,	open	Run	using
Windows+R.	Outlook	doesn’t	open	on	your	PC	for	many	reasons.	To	do	this,	press	and	hold	the	Ctrl	key	on	your	keyboard	and	double-click	the	Outlook	shortcut.	*	*	Suggestion:	If	Outlook	opens	now	without	problem,	proceed	to	Method	5	to	reduce	the	Mailbox	size.	Step	1:	Click	the	search	icon	on	the	taskbar,	type	control	panel,	and	press	Enter.	In
the	box,	type	the	following	path	and	press	Enter:	%localappdata%\Microsoft\Outlook	In	the	open	folder,	access	the	"RoamCache"	folder.	outlook.exe	/resetnavpane	Opening	Outlook	in	Safe	Mode	can	help	you	identify	if	one	of	your	add-ins	is	causing	the	problem.	This	is	a	very	basic	troubleshooting	step	but	you'd	be	surprised	how	often	it	works	for
issues	like	this	one.	To	do	that,	open	the	Run	dialog	box	using	Windows+R.	If	you	have	a	Microsoft	Exchange	account,	rebuilding	the	database	deletes	any	information	that	isn't	synced	with	the	server.	6.	Launch	Outlook.	In	the	app’s	left	sidebar,	select	"Account."	On	the	right	pane,	choose	Update	Options	>	Update	Now.	When	you	have	issues	with
the	app,	it’s	likely	the	app’s	cached	files	are	corrupted.	Or,	your	PC	may	have	a	virus	or	malware	infection,	preventing	your	app	from	launching.	Install	any	available	updates	you	see.	At	Mail	Setup	window	click	Data	Files…	3.	Step	2:	Scroll	down	to	locate	the	Microsoft	Office	suite	on	the	list.	If	you're	not	sure	which	version	you	have,	go	ahead	and	try
these	steps.	Check	Windows	for	updates.	In	this	case,	run	a	full	virus	check	on	your	PC	to	find	and	remove	any	threats.	Step	2:	Use	the	left	pane	to	navigate	to	Options.	Now	proceed	to	set	up	your	email	account	and	click	Next	to	proceed.	We’ll	use	the	Word	app.	Disable	Outlook	Add-in(s).	Follow	the	on-screen	instructions	to	finish	the	account	setup.
Navigate	to	Control	panel,	set	View	by	to	Small	icons,	then	open	Mail	(Microsoft	Outlook).	Method	3:	Repair	Microsoft	Office	Applications.	Step	3:	Select	Online	Repair	>	Repair.	Now	open	Outlook	and	see	if	the	problem	is	fixed.	Microsoft	includes	this	tool	with	all	Office	installations,	and	you	can	use	it	to	find	and	resolve	problems	with	all	your	Office
applications.	3.	Select	Add-ins	at	the	left	pane	and	then	choose	COM	Add-ins	on	the	right	(beside	'Manage').	At	Archive	options:	Select	the	option	Archive	all	folders	to	archive	all	mail	folders,	or	choose	Archive	this	folder	and	all	subfolders	and	then	select	the	folder	you	want	to	archive	(e.g.	the	Inbox	folder).	To	do	that,	launch	your	PC’s	Windows
Security	app.	Microsoft	Outlook	won't	open	on	your	Windows	11	PC?	Method	5:	Reduce	the	Mailbox	size	by	Archiving	Older	items.	Although	this	might	seem	like	an	unrelated	fix,	there	could	be	an	update	pending	in	Windows	Update	that	is	the	exact	fix	you	need	to	make	Outlook	open	again.	If	you	use	the	cloud-based	Microsoft	365	on	a	PC	or	a	Mac,
the	automated	Support	and	Recovery	Assistant	tool	can	diagnose	and	fix	many	issues,	including	the	problem	of	Microsoft	Outlook	not	starting.	In	the	"User	Account	Control"	prompt,	select	"Yes."	You’ll	see	the	Office	repair	tool	on	your	screen.	In	run	command	box,	type:	appwiz.cpl	and	press	Enter.	Here	are	some	common	fixes	that	should	work	when
Outlook	doesn't	open,	whether	you're	using	Windows	or	a	Mac.	Step	5:	In	the	Add	Account	window,	enter	your	account	details	>	hit	Next.	As	you	can	tell,	this	step	is	only	useful	if	your	problem	is	sporadic.	Regardless	of	the	specific	cause,	there	are	several	key	troubleshooting	fixes	to	try	that	might	help.	Scan	for	malware:	Malware	infection	is	another
possible	cause	for	such	issues	with	the	Outlook	app.	In	most	cases,	Outlook	doesn’t	tell	you	why	it	isn’t	opening,	which	leaves	you	guessing	as	to	what	has	caused	the	issue.	At	'Microsoft	Outlook	Inbox	Repair	tool',	click	Browse	and	select	the	Outlook	.PST	(or	.OST)	file	from	the	location	you	noticed	above.	Click	Yes	when	the	confirmation	prompt
appears.	In	this	app,	navigate	to	Virus	&	Threat	Protection	>	Scan	Options.	If	Quick	Repair	cannot	fix	the	problem	try	Online	Repair.	%localappdata%\Microsoft\Outlook	Step	2:	Press	Ctrl	+	A	to	select	all	the	files	and	folders	within	the	Outlook	folder	and	click	the	trash	icon	at	the	top	to	delete	them.	In	this	box,	type	the	following	command	and	press
Enter:	outlook.exe	/safe	If	Outlook	opens,	it	means	your	installed	add-ins	are	likely	the	culprit.	When	the	import	is	completed,	navigate	to	Mail	in	Control	Panel	and	delete	the	old	Profile.	Then,	restart	your	PC	and	launch	Outlook.	If	the	scan	reveals	anything	suspicious,	take	the	recommended	steps	to	remove	the	threat.	Run	an	Antivirus	Scan	on	Your
PC	If	your	PC	has	a	virus	or	malware	infection,	that	may	be	why	Outlook	isn’t	launching.	This	is	because	when	you	update	one	Office	app,	it	automatically	updates	all	other	Office	apps	on	your	PC.	Microsoft	Outlook	is	a	reliable	and	efficient	e-mail	client	that	can	be	used	for	both	personal	and	business	purposes.	If	Outlook	opens	in	Safe	Mode	but	won't
open	normally,	then	open	it	again	in	Safe	Mode	and	proceed	to	step-2	below	to	disable	Outlook	Addins.	The	first	method	of	solving	Outlook	crash	or	freeze	problems	is	to	disable	add-ons	that	may	prevent	Outlook	from	working	properly.	Leave	the	Quick	Repair	option	selected	and	click	Repair.	The	most	common	when	Outlook	not	opening,	is	a
corrupted	Outlook	data	file	(.PST	or	.OST).	Select	Repair	if	the	scan	finds	errors.	When	your	cache	files	are	deleted,	launch	Outlook,	and	the	app	should	open	without	problems.	Follow	the	on-screen	instructions	to	update	your	Office	apps.	1.	Search	for	and	select	Uninstall	a	program.	In	this	case,	you’ll	have	to	remove	your	app’s	cache	to	resolve	your
issue.	Microsoft	explains	which	folder	on	your	computer	holds	this	file.	In	this	case,	remove	those	add-ins	by	heading	into	File	>	Options	>	Add-Ins,	selecting	"Go"	next	to	the	"Manage"	drop-down	menu,	choosing	all	add-ins	on	the	list,	and	selecting	the	"Remove"	option.	The	content	remains	unbiased	and	authentic	and	will	never	affect	our	editorial
integrity.	When	the	repair	process	is	completed,	close	the	Inbox	Repair	Tool	utility.	When	the	repair	is	complete,	restart	Outlook.	Use	the	drop-down	menu	next	to	Manage	>	select	COM	Add-ins	>	click	the	Go	button	next	to	it.	In	the	Profile	Name	box,	enter	a	name	for	the	new	profile,	then	hit	OK.	One	reason	Outlook	fails	to	launch	is	that	you’ve
installed	faulty	add-ins	in	the	app.	If	the	problem	appeared	after	installing	Updates,	then	proceed	to	uninstall	them	and	see	if	that	fixes	the	problem.	When	your	add-ins	are	removed,	close	and	relaunch	Outlook.	Open	Outlook	in	Safe	Mode.	Restart	the	Outlook	app	after	this	and	enable	your	add-ins	one	by	one	until	the	problem	occurs	again.	Open
Control	Panel.	Since	your	app	doesn’t	open,	you’ll	have	to	use	another	Office	app	on	your	PC	to	trigger	the	update.	Another	technique	to	keep	Outlook	away	from	crashing	is	to	reduce	the	size	of	the	mailbox	by	archiving	older	items.	Method	2.	To	fix	it	when	Outlook	isn't	opening	on	your	PC,	you	can	remove	suspicious	add-ins,	run	a	full	antivirus	scan,
clear	Outlook's	cache,	repair	the	app	using	Office's	built-in	repair	tool,	or	update	your	Outlook	app.	If	the	program	opens	as	expected	in	Safe	Mode,	the	reason	it	won't	open	normally	is	likely	due	to	one	or	more	add-ins.	Even	$1	can	a	make	a	huge	difference	for	us	in	our	effort	to	continue	to	help	others	while	keeping	this	site	free:	If	you're	trying	to
open	Microsoft	Outlook	from	your	Start	menu	or	a	shortcut	icon	but	it	just	won't	launch,	don't	worry,	there	are	a	few	things	you	can	try	to	get	it	up	and	running	again.	Disable	Outlook	Add-ins	(in	Safe	Mode).	Method	4:	Create	a	new	Outlook	profile.	If	you	can't	open	Outlook	to	complete	this	step,	move	on	to	the	next	option	below.	Since	several
different	problems	can	cause	Outlook	not	to	open,	you	may	have	to	try	multiple	fixes	before	your	issue	is	resolved.	Restart	your	computer.	Then,	right-click	a	selected	file	and	choose	"Delete"	(a	trash	can	icon).	Enjoy	using	your	favorite	email	client!	Author:	Konstantinos	Tsoukalas	,	Last	updated:	November	25th,	2022	If	you	cannot	open	Outlook
because	it	crashes	or	freezes	when	opening	it,	continue	below	to	fix	the	problem.	This	only	works	in	Outlook	2016	and	older.	7.	Several	issues	could	cause	Outlook	to	open	incorrectly	or	not	at	all.	Using	the	Microsoft	utility	to	rebuild	a	corrupted	database	might	solve	the	problem	of	Outlook	not	opening	on	a	Mac.	Exit	all	Office	applications.Press	the
Option	key	and	select	the	Outlook	icon	in	the	Dock	to	open	the	Microsoft	Database	Utility.	Here,	enable	the	"Quick	Repair"	option	and	choose	"Repair."	Wait	while	the	tool	fixes	your	Outlook	problem.	(If	you	don't	see	the	outlook	data	file	in	the	location	you	noticed,	enable	hidden	files).	For	Outlook	2016,	2019	and	later,	select	the	File	tab,	then	choose
Info	>	Tools	>	Clean	up	old	items…*	Note:	In	Outlook	2010,	2013,	go	to	the	File	>	Info	>	Cleanup	Tools	>	Archive.	End	Outlook	processes	using	Task	Manager:	At	times,	Microsoft	Outlook	may	fail	to	load	its	interface	due	to	temporary	glitches.	Finally	click	the	OK	button	to	archive	the	old	items	(emails)	3.	If	the	app	still	doesn't	open,	you	can	try
resetting	your	view	settings	in	Outlook	by	putting	"outlook.exe	/cleanviews"	in	the	Run	box.	If	you	find	a	problem,	resolve	it	with	your	security	software,	reboot	your	computer,	and	try	to	start	Outlook	again.	Now	according	the	result,	proceed	as	follows:	If	Outlook	doesn't	open	in	Safe	Mode,	skip	to	Method-2	below.	Step	1:	Press	the	Windows	key	+	R
to	launch	the	Run	dialog	box,	type	the	following	path	in	the	text	box,	and	press	Enter.	Step	2.	If	Outlook	now	starts	up	without	a	problem,	reopen	it	in	Safe	Mode	and	enable	one	by	one	the	add-ons	(and	restart	Outlook),	until	you	discover	which	one	is	causing	the	problem.	Reset	the	navigation	pane.	Turning	your	computer	off	and	then	on	again	will
flush	Outlook	from	the	memory,	which	is	helpful	if	it	won't	open	because	it's	hanging	in	the	background.	Once	you	find	the	problematic	add-in,	remove	it	to	avoid	any	issues	in	the	future.	(At	the	final	repair	phase,	you	will	be	asked	if	you	want	to	create	a	backup.	However,	sometimes	Outlook	does	not	open	at	all	or	freezes	and	crashes	on	opening.	If
your	issue	with	Outlook	persists,	use	the	repair	tool’s	"Online	Repair"	option	to	fix	your	app	problems.	Navigate	to	Control	panel	open	Mail	(Microsoft	Outlook)	an	click	Show	Profiles.	If	this	article	was	useful	for	you,	please	consider	supporting	us	by	making	a	donation.	Consider	creating	a	new	Outlook	profile	and	clearing	the	app	data	if	nothing	else
works.	If	yes,	and	if	you're	using	a	POP	account,	proceed	to	import	the	emails	from	the	old	Outlook	profile	(.pst	file),	by	using	the	steps	below:	From	the	File	menu	choose	Open	&	Export	>	Import/Export	Select	Import	from	Another	Program	or	File	&	click	Next.	Repair	Outlook.	Then,	launch	your	Outlook	app,	and	it	should	open	without	problems.
Select	Outlook	Data	File	(.pst)	&	click	Next.	Restart	Outlook	after	the	process	completes.	Doing	so	should	help	you	identify	the	troublesome	add-in.	Go	in	order	so	you	have	best	chance	of	getting	back	to	your	inbox	as	quickly	as	possible.	In	Programs	and	features,	select	the	Office	version	you	have	installed,	and	click	Change.	Thanks	for	letting	us
know!	Get	the	Latest	Tech	News	Delivered	Every	Day	Subscribe	Tell	us	why!	If	you	can't	open	Outlook,	or	Outlook	disappears	or	crashes,	one	of	your	add-ins	may	be	to	blame	or	you	may	need	to	update	Outlook.	Click	Yes.)	8.	Try	these	troubleshooting	tips	to	get	the	Outlook	app	to	work	again.	Once	you’ve	used	this	app,	launch	your	Outlook	app,	and
it	should	work	as	expected.	Having	trouble	launching	Outlook	on	your	PC?	Maybe	you've	added	a	new	program	to	your	computer	that	doesn't	get	along	with	Outlook,	or	your	system	has	a	virus.	Select	Browse,	navigate	to	your	personal	folders	(.pst)	file,	choose	the	file,	then	select	Start.	This	option	takes	longer	than	the	first	one	and	requires	an	active
internet	connection	to	resolve	your	app	issues.	In	the	Processes	tab,	select	Microsoft	Outlook	>	click	End	task.	To	do	that,	open	Windows’	Run	dialog	box	by	pressing	Windows+R.	Check	the	box	with	Include	items	with	"Do	not	AutoArchive"	checked	to	archive	individual	folders.	So,	proceed	to	scan	and	repair	the	Outlook	data	file	errors	by	following
the	instructions	below:	1.	You	can	do	this	through	the	Run	dialog	box.	You	can	update	your	Outlook	app	to	resolve	your	launch	problem.	Outlook	profiles	can	become	corrupted,	causing	all	sorts	of	problems,	including	Outlook	not	opening.	Repair	Outlook	Data	File.	Old	app	versions	often	have	many	issues,	and	these	issues	are	usually	fixed	in	newer
versions.	Step	4:	Uncheck	the	boxes	to	disable	add-ins	and	click	OK.	Your	issue	should	now	be	resolved.	Then	hit	the	Go…	button.	*	*	Note:	Before	proceeding	with	the	suggested	methods	try	the	following:	If	you're	using	a	third-party	antivirus	program,	try	to	disable	it	and	see	if	the	problem	persists.	2.	And	that’s	how	you	get	Outlook	to	open	without
problems	on	your	Windows	11	or	Windows	10	PC.	2.	Close	all	Office	applications.	In	this	case,	you	can	reset	your	view	settings	before	opening	the	app.	Step	3:	In	the	Outlook	Options	window,	switch	to	the	Add-ins	tab.	4.	Method	1.	Choose	a	date	under	the	Archive	items	older	than	option.	You	may	have	installed	an	add-in	that’s	causing	problems	with
the	app.	Uncheck	all	the	boxes	to	disable	all	Add-ins,	then	press	the	OK	button.	To	do	so,	follow	the	steps	outlined	below.	9.	Step	3:	Click	Show	Profiles.	If	your	Outlook	version	is	outdated,	that	may	be	why	you	can’t	open	it.	Right-click	Microsoft	365	and	choose	Change.	That's	it!	Which	method	worked	for	you?	Here,	select	all	files	by	pressing	Ctrl+A.
Start	Outlook	in	Safe	Mode.	A	recent	update	could	include	a	fix	for	the	problem.	Click	Browse,	select	the	old	Outlook	PST	file	from	the	location	you	noticed	in	Method-2	above	and	&	click	Open.	Back	up	any	Outlook	data	stored	only	on	your	computer	before	you	rebuild	the	database.	Step	1:	Right-click	on	the	Start	icon	>	select	Installed	apps	from	the
list.	If	Outlook	still	doesn't	open,	use	the	Inbox	Repair	tool	to	find	and	possibly	fix	the	problem.	Step	2:	Change	the	view	type	to	Large	icons	and	click	on	Mail	(Microsoft	Outlook).	Step	4:	Click	on	Add	>	enter	the	name	for	the	new	profile	>	click	OK.
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